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1 Georock 3D

 

GeoRock 3D is a program for three dimensional analysis of rock

fall and for the design and optimisation of protective works utilising

a sophisticated algorithm for spatial analysis.

Slope modelling

The slope in question is generated from an xyz mesh that may be

imported from formats or suitable software.

The triangulation technique is extremely important and it is

recommended that Incremental Delaunay or anysotropic

triangulation are used.

In this respect the Geostru software "Trispace" is eminently

suitable.

 A tridimensional model can be imported directly from chart work

using  Geostru Autocad Application (G.A.A.)

Terrain properties

The slope is discretized in homogeneous zones having similar

mechanic characteristics, namely normal and tangential restitution

coefficients.

Block characteristics

Geometric characteristics are specified for a spherical block rotating

around its center of gravity, and mechanicaly its hardness and

mass.

Launch sites

Launch sites can be indicated directly on the 3D model specifying,

for each launch, the launch velocity.

Calculation

This provides three-dimensional trajectories, speed and energy.

Protective works

Protective works can be inserted directly on the 3D model and their

position optimized in relation to the displayed trajectories.

Barrier archive
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Facilities are provided for the archive of standard barriers that may

be reutilised directly on the 3D model.

Protective works sizing

Geostru Software provides a tool, BARRIER DESIGN (B.D.) for the

design a verification of rigid or elastic barriers.

Interfaces

This software interfaces with Geostru softwares Trispace and

Georock 2D.

1.1 Home

1.1.1 GeoDropBox

User can connect their GeoDropBox account to upload and save files

directly from the software
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1.1.2 General and Personal Data

In General Data and Personal Data it is possible to enter the project data

and the professional’s Master Data. This data will then be printed in the

output report.

1.1.3 Elevation attributed plane

Georock 3D is based on the three-dimensional definition of the surface

through a dimensioned plane.

Defining a correctly quoted plan is indispensable as it is the predominant

data of the analysis.

Therefore, it is advisable to use software for the generation of the plan

quoted with triangulation techniques of the incremental Delaunay type

or with anisotropic triangulation.

The Trispace software produced by Geostru software is a tool specially

created for 3D analysis of the territory, which allows you to generate
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sophisticated meshes with many analysis options, including incremental

and anisotropic triangulation.

It is also possible to extract three-dimensional points from 3D

cartographies through G.A.A (Geostru Autocad Applications) which

can be triangulated with dedicated software.

Also, the reading format of the quoted plane is text, each line contains

the coordinates of the triangle in the format [x,y,z] [x,y,z] [x,y,z].

1.1.3.1 Import of an elevation attributed plane

Before developing a project the import of information related to the

triangulation of the work area must be done. GeoRock 3D is perfectly

compatible with the triangulations generated using TriSpace, and these

triangulations can be imported using the proper command in Data menu.

1.1.4 Materials assignment

The software offers the facility of a personalized database which gathers

a wide range of materials that can be used for different regions of the

triangulation.

For every material is necessary to define the Rn and Rt restitution

parameters , the description and a color that allows the identification of

the area.

A material can be assigned to a single element or to an entire region.
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Single element

To assign a material to a single element choose the appropriate tool,

click with the mouse on the element  to alter and select a material from

the pop-up window.

N.B.

To assign the same material to other single elements press the "Ctrl"

key while selecting the elements.
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Region

To assign a material to a group of elements choose the appropriate tool,

select an area from the graphic, click with the mouse and choose a

material from the pop-up window.

Valori dei coefficienti di restituzione in letteratura

Valori ricavati da prove in sito da Pfeiffer e Bowen (1990)

CARATTERISTIC

HE DEL PENDIO 
Kn Kt

SMOOTH

SURFACES OF

RESISTANT

MATERIAL SUCH

AS ROAD OR

ROCKY SURFACE

0.37 – 0.42  0.87 – 0.92

PREVALENCE OF

INTACT BEDROCK

WITH ISOLATED

BLOCKS

0.33 – 0.37 0.83 – 0.87

 DETRIT

CONSISTING OF

LARGE BLOCKS

WITH LITTLE

AFFIORATING

VEGETATION

0.30 – 0.33 0.82 – 0.85

DETRIT COVERED

BY ABUNDANT

VEGETATION AND

SPARSELY

VEGETATED SOIL 

0.28 – 0.30 0.80 – 0.83

SLOPE IN THE

EARTH.
0.78 – 0.82

Richards, 1988
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CHARACTE

RISTICS

OF THE

SLOPE

Kn Kt

BIBLIOGRA

PHIC

REFERENCE

AFFLORATIN

G ROCK  
0.90 – 0.80 0.75 – 0.65

PITEAU &

CLAYTON 

DETRIT AND

AFFIORATIN

G ROCK 

0.80 – 0.50 0.65 – 0.45

SOLID

DETRIT AND

ROCK 

0.50 – 0.40 0.45 – 0.35

VEGETATION 0.40 – 0.20 0.30 – 0.20

ROCKY

SUBSTRATE

(BEDROCK)

0.53 0.99 HOEK

(RAPPORTO

NON

PUBBLICATO

PER I

“DEPARTMEN

TS OF

TRANSPORT

ATION

IN USA,

1987)

ROAD

SURFACE 
0.40 0.90

AFFLORATIN

G ROCK
0.35 0.85 

DETRIT 0.32 0.82

DETRIT AND

VEGETATION
0.32 0.80 

SOIL WITH

LITTLE

VEGETATION

0.30 0.80

1.1.5 Points file import (x, y, z)

The geometry of the slope can be imported from text files with specified

coordinates x,y,z of each point organized in 3 fields (columns): each

record (row) indicates a point.

The coordinates to be imported must be flat, that is, expressed in

m or other flat size and not in latitude and longitude or angles.

The import command can be reached from "Home">"Import 3D model

(point files (x,y,z))":
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The reading window of the text file containing the coordinates of the

points will be opened:

Where in the top bar we can find:

· New : allows re-initialization of the import by deleting the loaded

data;

· Open  : Opens the opening file dialog;

· Assign Georock3D: after triangulation, if the result is the desired one,

the geometry is assigned to the software;

· The import window can be divided into three areas:
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1. File Preview: this area shows a preview of the text file to be opened;

2. File extraction: here you can set import parameters such as the field

separator (columns), the number of the row from which to start the

extraction, and the numer of the field (column) of the X, Y, Z

coordinates. Pressing Extract will bring up another dialog box to filter

the data:

The Mesh button starts the triangulation of the points and Stop stops it;

3. 3D preview: The 3D preview of the triangulation is displayed.

Here is a short tutorial on how to import geometry from a text file:

Breve tutorial sul processo di
importazione della geometria nel

software Georock 3D di Geostru. Il file di
testo nell'esempio contiene le

informazioni delle coordinate X,Y, Z dei
punti di un versante.

1.1.6 Selecing a launch area
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The launch site of the block is defined by selecting, with the mouse, an

area from the graphic.

For this area the number of blocks to analyse, along x and y directions,

in a positive direction, must be defined.

The software will provide the automatic placing of the blocks in the

selected area, considering as elevation the plane elevation in the

application point.

1.1.7 Initial conditions

The program allows the personalization of the launch position, the

definition of the initial velocity components along the coordinate axis,

assigning the density and the diameter for every block subjected to 

trajectory computation. 
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1.1.8 Barriers assignment

Using the mouse, the barriers can be inserted in a spatial arrangement.

Every barrier is formed by one ore more segments, each one having its

own color, description, height, inclination and a maximum absorption

energy.

The barrier position can be modified with the mouse directly on the

graphic.

After defining the barrier, the last segment must be confirmed with a click

on the right mouse button.
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1.1.9 Markers

Markers

You can insert cylindrical elements as references to the area. Once

inserted through the tool "Edit markers" you can change the

coordinates, radius, height and the color.
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1.2 View

From the View menu you can use all those tools for graphical

visualization of the 3D model.

1.2.1 Raster image

A raster image can be inserted in the project only after importing the

elevation attributed plan.

The import procedure starts with the choice of the jpg image file that

contains the representation to be included in the project. The calibration

of the image to use starts through a guided procedure when the "Start

Calibration" button is pressed. The user is asked to select with the

mouse two points on the map with known coordinates, expressed in

same reference system used for the elevation attributed plan.

ATTENTION:

The coordinates must be expressed in the same reference system used

for the elevation attributed plan.
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To obtain a correct calibration of the map is necessary to select two

points not close to each other and arranged diagonally.

Through the "Tools" menu of the main window the user is given the

option to delete the imported image, to re-import or view the properties.

 

We included an import example in the Raster Import. The digital model

has been realized through GeoStru Maps.

1.2.2 Gradient

The Gradient option allows you to view the mesh based on 4 different

options:

· Color according to the material (user-defined lithology);

· Color according to altitude;

· Transparent elements (transparent mesh);

· Raster surface (if a raster image is loaded).

1.3 Instruments

1.3.1 Crop digital plan quoted
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With this option, selecting an area in the mesh will delete all items outside

it:
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1.3.2 Section

To generate a section of the work area select the proper tool and define

with the mouse a section line. 

At the ending of the selection, the section will be displayed in a separate

window and it can be exported in edp format.

The sections can be saved in edp format. 

The edp format is an export format for the GeoStru software files. This

type of files can be read by GoeRock 2D, Slope, etc.

1.4 Computation, Graphs

Once the input phase is done, the software is able to determine the

blocks motion as a function of the impacts on the soil and on eventual

barriers previously defined. The trajectories are displayed on the graphic

as they are calculated by the program.
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For every trajectory information as block initial position, minimum and

maximum velocity values and absolute position are available. The user

can choose to view only the trajectories he is interested in. By scrolling

with the mouse on a trajectory, the block's elevation, the velocity (as a

module) and the energy in that point are displayed. 

1.4.1 Animation
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Besides the tridimensional static view of the trajectory, calculated for

every block, an animated view can be displayed.

The animation can be interrupted, speed up or slow down. 

2 Geoapp

Geoapp: the largest web suite for online
calculations
 
The applications present in Geostru Geoapp were created to support the

worker for the solution of multiple professional cases.

Geoapp includes over 40 applications for: Engineering, Geology,

Geophysics, Hydrology and Hydraulics.

 

Most of the applications are free, others require a monthly or annual

subscription.

 

Having a subscription means:

 

• access to the apps from everywhere and every device;

• saving files in cloud and locally;

• reopening files for further elaborations;

• generating prints and graphics;
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• notifications about new apps and their inclusion in your

subscription;

• access to the newest versions and features;

• support service throught Tickets.

2.1 Geoapp Section

General and Engineering, Geotechnics and
Geology  

 

Among the applications present, a wide range can be used for GeoRock.

For this purpose, the following applications are recommended:  

 

Ø Anchored mesh systems

Ø Nailing passive bars

Ø Rigid and elastic rockfall barriers

Ø Tiranti

Ø Analysis stability of flat surfaces

Ø Slips along a plane

Ø 3D Wedge

3 Theoretical notes

The model used for the computation of the trajectories of rock

falls considers the blocks like point block that have an impact on

an elevation attributed plane. This plane is formed by a grid of

tridimensional nodes that form a triangular mesh which

represents the entire area between the launch and the stopping

of the blocks.

The elements of the grid must be defined so that, in the inside of

the perimeter, the inclination and the direction of the slope

together with the physical parameters of the model ( the normal

and tangential restitution parameters), defined as ratio of the

post and pre - impact energy, can be considered constants.  

The triangles must be dimensioned right because they can be

considered "big" regarding the volume of the blocks and "little"

regarding the area involved.
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The definition of the launch area assumes a previously analysis

of the launch niche so that for every block it can be defined a

launch velocity as a function of the initial route along the wall.

This model also carries out the analysis for the positioning and

sizing of protective works. The initial computation verifies that

the block knocks against the barrier and does not climb over it,

so it verifies that the impact kinetic energy of the block can be

completely absorbed by the protective work.

This model for the computation of trajectories of rock falls is

mostly used for the design of embankments as protective

works because, thanks to their high expansion, the

embankments can be able to intercept a great number of blocks

before requiring maintenance interventions or reconstruction,

and assure a remarkable absorption energy, typically generated

by long fall routes. 

For the design of more precise works, like rock fall nets, the

studies on the fall route of blocks are more accurate in the two-

dimensional models that are more sophisticated in the

description of the physical phenomenon.

The trajectory of the block can be determined by using the motion

equations of a block. Referred to a cartesian orthogonal axis system

this equations are:

 
s = v × t + s0

z = - 1/2 × g × t2 + v × t + z0                                              

 
where:

v = block's velocity;
t = time;
g = gravitational constant;
s = crossed space;

 
In this way the trajectory of the motion results to be formed by a series of
parabolas drawn from the launch point to the point where the block knocks
first the slope, in the initial phase of the motion, and between two
consecutive impact points on the slope, or at the foot, until the stopping
point. 
By indicating with vn and vt the components (normal and tangential) of the

velocity before the impact,  v'n and v't after the impact can be calculated

using the following relations:
 
v'n= vn × ln
v't= vt × lt
 
where:
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ln and lt are the restitution coefficients, varying in the interval 0-1

 
 

 

3.1 Lumped Mass Method

The assumptions of the Lumped Mass model are:

1. a plane outline, a slope profile similar to a broken line consisting of

straight segments;

2. point block and negligible air resistance.

In this case the trajectory of the block can be determined using the

equations of the motion of a body

The motion is characterized by a constant acceleration a=g=-guy and

the initial conditions are v=v0 at time t=0, the moment of launch.

From the definition of acceleration in plane motion we obtain the

following relationship:
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projected motions are:

0
2

0

2

1
ytvtgy

xtvx

y

x




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where:

vx horizontal component of the block speed;

vy vertical component of the block speed;

t time;

g acceleration of gravity;

x0 abscissa of the point where block detaches from the slope or bumps

in the fall motion;

y0 ordinate of the point where the block is detached from the slope or

bumps in the fall motion.

Along the x-axis the motion is uniform, along the y-axis uniformly

accelerated.
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In this way the trajectory of the motion of the block is composed of a

series of parabolas drawn between the point where the detachment

occurs and the point where the block hits the slope for the first time, in

the initial phase of the motion, and between two subsequent points of

impact on the slope, or at the foot, afterwards, until the end point of

arrest.

The coordinates of the points of impact and the components of the

velocity are determined by solving the system between equation (1) and

the equation of the straight lines which representing the slope profile.

In practice, one proceeds from the point where the block is detached and

solve this system of equations by considering from time to time the

different equations of the straight lines that contain the successive
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segments of the broken line up until find the coordinates of a point,

impact point, which belongs to the parabola representing the trajectory

and falls within one of the segments of the broken line and is therefore

also a point of the slope.

This point represents the first point of impact of the block on the slope.

The procedure is repeated starting from this point to determine the next

arc of the trajectory and a new point of impact.

The loss of kinetic energy due to friction and impact can be modeled by

reducing the speed of the falling block each time it hits the slope.

In particular, indicating with vn and vt the components (normal and

tangential) of the velocity before the impact, after the impact v'n, v’t can

be calculated by means of the relations:

ttt

nnn

Rv'v

Rv'v





Rn and Rt are called variable coefficients of restitution in the interval 0-1

4 Contact

GeoStru Software

Web: https://www.geostru.eu/
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